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Chapter 3
Constructive Solid Geometry Concepts

Leamming Qhjjeciives

¢ Understand Constructive Solid
Geometry Concepts

¢ Create a Binary Tree

¢ Understand the Basic Boolean
Operations

¢ Set up Grid and Snap Intervals

¢ Understand the Importance of Order of
Features

¢ Create Placed Features

¢ Use the Different Extrusion Options
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Introduction

In the 1980s, one of the main advancements in solid modeling was the development of
the Constructive Solid Geometry (CSG) method. CSG describes the solid model as
combinations of basic three-dimensional shapes (primitive solids). The basic primitive
solid set typically includes Rectangular-prism (Block), Cylinder, Cone, Sphere, and
Torus (Tube). Two solid objects can be combined into one object in various ways using
operations known as Boolean operations. There are three basic Boolean operations:
JOIN (Union), CUT (Difference), and INTERSECT. The JOIN operation combines
the two volumes included in the different solids into a single solid. The CUT operation
subtracts the volume of one solid object from the other solid object. The INTERSECT
operation keeps only the volume common to both solid objects. The CSG method is also
known as the Machinist's Approach, as the method is parallel to machine shop
practices.

Primitive Solids

JOIN INTERSECT

CUT
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Binary Tree

The CSG is also referred to as the method used to store a solid model in the database. The
resulting solid can be easily represented by what is called a binary tree. In a binary tree,
the terminal branches (leaves) are the various primitives that are linked together to make
the final solid object (the root). The binary tree is an effective way to keep track of the
history of the resulting solid. By keeping track of the history, the solid model can be re-
built by re-linking through the binary tree. This provides a convenient way to modify the
model. We can make modifications at the appropriate links in the binary tree and re-link
the rest of the history tree without building a new model.

. / Terminal branches

Result

Union




Constructive Solid Geometry Concepts 3-5

The Locator Design

The CSG concept is one of the important building blocks for feature-based modeling. In
Autodesk Inventor, the CSG concept can be used as a planning tool to determine the
number of features that are needed to construct the model. It is also a good practice to
create features that are parallel to the manufacturing process required for the design. With
parametric modeling, we are no longer limited to using only the predefined basic solid
shapes. In fact, any solid features we create in Autodesk Inventor are used as primitive
solids; parametric modeling allows us to maintain full control of the design variables that
are used to describe the features. In this lesson, a more in-depth look at the parametric
modeling procedure is presented. The equivalent CSG operation for each feature is also
illustrated.

» Before going through the tutorial, on your own make a sketch of a CSG binary tree of
the Locator design using only two basic types of primitive solids: cylinder and
rectangular prism. In your sketch, how many Boolean operations will be required to
create the model? What is your choice of the first primitive solid to use, and why?
Take a few minutes to consider these questions and do the preliminary planning by
sketching on a piece of paper. Compare the sketch you make to the CSG binary tree
steps shown on the next page. Note that there are many different possibilities in
combining the basic primitive solids to form the solid model. Even for the simplest
design, it is possible to take several different approaches to creating the same solid
model.
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Modeling Strategy — CSG Binary Tree
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Starting Autodesk Inventor

1. Select the Autodesk Inventor option on the Start menu or select the Autodesk
Inventor icon on the desktop to start Autodesk Inventor. The Autodesk Inventor

main window will appear on the screen.
=B T8

% iects  Open

7 Mew [Ctri+M) Samples

Get Started 2. Select the New File icon with a single click of the

left-mouse-button in the Launch toolbar.

Launch

X/
°e

Every object we construct in a CAD system is measured in units. We should
determine the value of the units within the CAD system before creating the first
geometric entities. For example, in one model, a unit might equal one millimeter of
the real-world object; in another model, a unit might equal an inch. In Autodesk
Inventor, the Choose Template option is used to control how Autodesk Inventor
interprets the coordinate and angle entries.

I Create Mew File

3. Select the Metric tab as shown below. We will use the
millimeter (mm) setting for this example.

4 | Templates
./ English

| ks MetEc |
. MoltiDesign

¥ Part—Create 2D and 3D objects — | 4. Inthe New File — Part
Template area, select the

@ @ @ @ ?;:\Sg.ard(mm)-ipticonas

Sheet Sheet Standard Standard
Metal Metal (DIN).ipt I:mmhift

(DIN).ipt (mm).ipt 5. Confirm the Parametric-

Modeling project is activated;
¥ Assembly — Assemble 2D and 3D components note the Projects button is
available to view/modify the

% % % % % active project.

iold hold Standard Standard Project File: [Parametric—MudeIing.ipj v]

m

6. Pick Create in the Startup dialog box to accept the selected settings.
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Base Feature

In parametric modeling, the first solid feature is called the base feature, which usually is
the primary shape of the model. Depending upon the design intent, additional features are
added to the base feature.

Some of the considerations involved in selecting the base feature are:

e Design intent — Determine the functionality of the design; identify the feature that is
central to the design.

e Order of features — Choose the feature that is the logical base in terms of the order
of features in the design.

e Ease of making modifications — Select a base feature that is more stable and is less
likely to be changed.

1. Activate the Start 2D Sketch icon with a
single click of the left-mouse-button.

ALERR

Loft
Sta rlﬂ_ | Y L i L G
20 Skg 2D Sketch (5)

Sketq Creates a 20 sketch on a planar
a work plane on an assernbly.

2. Move the cursor over the edge of the XY Plane in the graphics area. When the XY
Plane is highlighted, click once with the left-mouse-button to select the Plane as the
sketch plane for the new sketch.

Select plane to create sketch or an existing sketch to edit
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GRID Display Setup

1. In the Ribbon toolbar panel, select
[Tools] > [Document Settings].

Manage View  Environments  Get Started  Vault £
K ﬁ z [
@‘ Clear - } = @ Customize {
@& Adjust —= =
ance Application |Document| Exchange
Options | Settjngs |App Manager qF Add-Ins

LS =

Document Settings

2. Inthe Document Settings dialog box, click on the Sketch tab as shown in the below
figure.

3. Set the X and Y Snap Spacing to 5 mm.

Partl Document Settings E

Standard | Units | Sketch |Mudeling I Bill of Materials I Default Tolerance
20 Sketch —]

3. Set to S mm
Snap Spading A splay

X s.uuurﬁ// wm

4.Setto S
¥ 5.000 rpf‘( Major every /
it

minar lines

Line Weight Display Options

4. Change Grid Display to display one major line every 8 minor lines.

et =B
5. Pick OK to exit the Sketch
Settings dialog box.

» Note that the above Snap
Spacing settings actually set
the grid spacing in Autodesk
Inventor. Although the Snap
to grid option is also
available in Autodesk
Inventor, its usage in

X parametric modeling is not

o recommended.

» On your own, use the dynamic Zoom function to view the grid setup. Refer to Page
2-26 on how to switch on the grid lines display options if necessary.
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» A rectangular block will be first created as the base feature of the Locator design.

NCrNg
= Circle Arc

-

D [\ Fillet ~
Text -
Rectangle A
M —i- Point
Rectangle

6. Switch back to the Sketch tab and

% select the Two point rectangle
Projs command by clicking once with the
Geom left-mouse-button.

7.
below.

Create a rectangle of arbitrary size by selecting two locations on the screen as shown

Second Corner

& =

¢

L

First Corner

2}

——_ [ TwoPointRectangle & ]

L%" Project Geometry

1

Dirmen

B
=

2 Ly O @ B mage
& 7 4 Bl Points
=i xS = BN ACAD

8. Inside the graphics window, click once with the
right-mouse-button to bring up the option menu.

9. Select OK to end the Rectangle command.

10. Activate the General Dimension
command by clicking once with the
left-mouse-button. The General

General Dimension (1)

‘ Places a dimension in a 20 or 30 sketch.

Dimension command allows us to
quickly create and modify dimensions.
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|+ Finish 2D Sketch

11. Inside the graphics window, click once with the right-

% mouse-button to bring up the option menu and click
T+ Previ w F5 | Edit Dimension to turn OFF the editing option while
{n} Home View F& creating dimensions.

How To...

12. The message “Select Geometry to Dimension” is displayed in the Status Bar area at
the bottom of the Autodesk Inventor window. Select the bottom horizontal line by
left-clicking once on the line.

12. Select the bottom
horizontal line as the
geometry to dimension. \

=3 100,402 f==

13. Pick a location
below the line to place
the dimension.

V

13. Move the graphics cursor below the selected line and left-click to place the
dimension. (Note that the value displayed on your screen might be different than what
is shown in the above figure.)

14. On your own, create a vertical size dimension of the sketched rectangle as shown.

19.194

=3 100402 ———————F==

(7 Two Point Rectangle ) 15. Inside the graphics window, click once with the right-

mouse-button to bring up the option menu and click
|_ OK to end the Dimension command.

Q%’ Project Geometry )
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Model Dimensions Format

1. Inthe Ribbon tabs, select

[Tools] 2 [Document Settings].

D @‘ Clear = }E @ Customize |
@ Adjust —== =
ance Application |Docurnent| Exchange
Options | Settjngs |App Manager =p Add-Ins
ppearance - - =
Document Settings

View Environments

Get Started

Vault £

2. Inthe Document Settings dialog box, set the Modeling Dimension Display to
Display as value as shown in the figure.

Partl Document Settings

| Standard | Units |Sketch | Modeling I Bill of Materials | DefauItToIerance|

=5

3. Also set the precision to

Units
Length
Angle

Modeling Dimension Display

Linear Dim Dizplay Predsion

0. -

Angular Dim Display Predsion

2,12 -

11
212 ay
3123

Time
Mass

(@ Display as value

(©) Display as name

() Display as expression
() Display tolerance

() Display predise value

no digits after the
decimal point for both the
linear dimension and
angular dimension
displays as shown in the
above figure.

Modifying the Dimensions of the Sketch

1

Edit Dimension : dl

15, 194057 mm

(el
:

4. Pick OK to exit the Document Settings dialog box.

Select the height dimension that
is to the right side of the sketch
by double-clicking with the left-
mouse-button on the dimension
text.
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11 2. Inthe Edit Dimension window, the

g current length of the line is displayed.

1 Enter 50 to set the selected length of the
sketch to 50 millimeters.

Edit Dimension : dl

50 mm

3. Click on the Accept icon to accept the
entered value.

» Autodesk Inventor will now update the profile with the new dimension value.

4. On your own, repeat the above steps and adjust the dimensions so that the sketch
appears as shown below. Also exit the Dimension command.

Repositioning Dimensions

1. Move the cursor near the vertical dimension; note
that the dimension is highlighted. Move the cursor
slowly until a small marker appears next to the
cursor, as shown in the figure.

@37:‘

2. Drag with the left-mouse-button to reposition the
selected dimension.

3. Repeat the above steps to reposition the horizontal
dimension.

T
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Using the Measure Tools

Autodesk Inventor also provides several measuring tools that allow us to measure area,
perimeter and additional information of the constructed 2D sketches.

-0 - - ‘W] 1. Inthe Inspect Ribbon tab, left-click once on the
30 Model  Sketch  Annot: Measure option as shown.

— ] e Note that other measurement options are also

) available in the toolbar.
Measure| Region

> | Properties

Measure (M)
Model

Measures position, length, angle,

%ﬂ 2. Click on the top edge of the rectangle as
shown.
Measure w [B2 =
Selection 1 (Curve) — 3. The associated length measurement of the

selected geometry is displayed in the Length
Length  75.000 mm dialog box as shown.

Advanced Settings

{ {g} Home View )
4. Inside the graphics window, right-click once to bring up
the Option menu and select Restart as shown.
" Previous View F5
How To...

5. Move the cursor on top of any of the
edges and click once with the right-
mouse-button to bring up the Option
menu and choose Select Other... as
shown.

Restart
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p 6. In the Selection list, left-click once to
| |(2curve Loop pick the Curve Loop option as
1. Curve shown.
|2. Curve Logop
Selection 1 (Curve Loop) ~
Length 250.000 mm .
Advanced Settings < ° The perln/l'ete}j Ofthe
rectangle is displayed
R as shown.

250.000 mm Length

N— S
E Measure & = 7. Click on the [X] icon to end the Measure
Selection 1 (Curve Loop) e command as shown.

Length 250.000 mm

Advanced Settings <

8. In the Inspect Ribbon tab, left-click once on the Region Properties option as
shown.

R A%-B-° @

File Elny) Sketch  Annotate G« Tocols  Manage

Measure| Region Autolimits
Propertigs Settings
Measure

Region Properties
Model )

Calculates one or more closed sketch loops you select in a 2D
@Partl sketch.
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9. Click on the inside of the rectangle;

notice the region is highlighted as the
b5 4 cursor is moved inside the rectangle, as
[Region Properties, Select sketch loops. shown.

| —

Dual Units . )
[Nme v] 10. In the Region Properties dialog box, click on the
Calculate button to perform the calculations of the
[ Calqiate ] associated geometry information.
=1 =]
Iy
Region Properties E
Selections BVt o . . .
. None - ¢ In the Region Properties dialog box,
[% Sketch Loopi In the R g P D (f dial j4 b
" Cickto add the detailed region properties are
calculated and displayed, including

Area = 3750 mm"2
Perimeter = 250 mm

»

the Area Moments of Inertia, Area and

Perimeter.

Centroid,with respect to Sketch Originfmm)
X=2

Y=25 11. Click Done to exit the Region

I;rﬁa with respect to Sketch Origin{mm}): Propertles Command'

m

Inertia Tensor(mm~4)
I = 3125000
Iy = 216590
Iyx = 216590
Iyy = 1777828

Polar Moment of Inertia = 4902828 mm "4

Area Moments of Inertia with respect to Principal Axes{mm~4):
Ix = 731250
Iy = 1757813

Polar Moment of Inertia = 2539063 mm~4

ents Get Started Autodesk A360

12. Select Finish Sketch in the Ribbhon to end the

¥ Refresh Sketch option.

Finish Sketch
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Completing the Base Solid Feature

1. Inthe 3D Model tab select the Extrude command
by clicking the left-mouse-button on the icon.

2. Inthe Extrude pop-up window, enter 15 as the
extrusion distance. Notice that the sketch region is
automatically selected as the extrusion profile.

20 Sketch ~

Sketch Extrude (E)
Model  w Creates a feature or bo
— profiles create solids o

ﬁ
| shape [more |

Profile e

Solids . Seml 7
ovon )

Extents

I

[IMatch shape

v &t [ mh’” Cancel
A

3. Click on the OK button to proceed with creating the 3D part. Use the Dynamic
Viewing options to view the created part. Press F6 to change the display to the
isometric view as shown before going to the next section.
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Creating the Next Solid Feature

1. Inthe 3D Model tab select the Start 2D
Sketch command by left-clicking once on the
) g] @ & Swe icon.
iod Loft
Starf™ F—t—n—
2D Ske 2D Sketch (5)

Sketq Creates a 2D sketch on a planar
a work plane on an assembly.

Inspect

2. In the Status Bar area, the message “Select plane to create sketch or an existing
sketch to edit” is displayed. Autodesk Inventor expects us to identify a planar surface
where the 2D sketch of the next feature is to be created. Move the graphics cursor on
the 3D part and notice that Autodesk Inventor will automatically highlight feasible
planes and surfaces as the cursor is on top of the different surfaces.

3. Use the ViewCube to adjust the display viewing the bottom face of the solid model
as shown below.

4. Pick the bottom face
of the solid model.

4. Pick the bottom face of the 3D model as the sketching plane.

» Note that the sketching plane is aligned to the selected face. Autodesk Inventor
automatically establishes a User-Coordinate-System (UCS) and records its location
with respect to the part on which it was created.
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5. Select the Center Point Circle command by
clicking once with the left-mouse-button on the
icon in the Sketch tab.

M 7| Center Point Circle (Ctrl

Creates a circle using a cq

» We will align the center of the circle to the midpoint of the base feature.

6. Inside the graphics window, click once with the right-mouse-button to bring up the
option menu and choose the snap to Midpoint option.

" AutoProject
:1—: Previous View
G} Home View

7. Select the left edge of the base feature to align the
center point of the new circle.

8. Select the green dot to align the midpoint of the
line.

9. Select the top corner of the base feature to
create a circle as shown in the figure.

10. Inside the graphics window, click once
with the right-mouse-button to display the
option menu. Select OK to end the Circle
command.

(=3 Two Point Rectangle |

(45 _Projct Geometry )|

-2 |
& H Fi 11. In the Ribbon toolbar, select Finish Sketch to exit the
EL} Show Format  |Skefth Sketch mode.

Format - Exit

=
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= & 32
12. Press the function key F6 once or select Home View in the
L ViewCube to change the display to the isometric view as shown.

13. In the 3D Model tab, select the Extrude
command by left-clicking the icon.

20 Sketch ™

Sketch Extrude (E)
Model Creates a feature or bo
— profiles create solids o

[Berude |y 14. In the Extrude pop-up control, the Profile button is activated as

shown; Autodesk Inventor expects us to identify the profile to
be extruded. Move the cursor inside the circle we just created
Brofie and select the region as the profile to be extruded.
E Solids
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15. In the Extrude pop-up control, enter 40 as the blind extrusion distance as shown
below. Set the solid operation to Join. Click on the Direction 2 button to reverse the
direction of extrusion (upward) as shown below.

ﬁ

Join option

Profile \@

Extents
Solids E m b
@

Enter 40

Output
E |rect|or| 2

9 ers [ oc [ cancl |

» Note that most of the settings can also be set through the icons displayed on the
screen.

16. Click on the OK button to proceed with the Join operation.

e The two features are joined together into one solid part; the CSG-Union operation
was performed.

CSG UNION
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Creating a Cut Feature

We will create a circular cut as the next solid feature of the design. We will align the
sketch plane to the top of the last cylinder feature.

30 Model WS 1. In the 3D Model tab select the Start 2D Sketch command
o by left-clicking once on the icon.
I-‘% o &
Sta Extrude Revol
2D Sketch ™
Sketch

2. Pick the top face of the cylinder
as shown.

2. Pick the top face to
align the sketch.

MGG 3. Sclect the Center Point Circle command by
clicking once with the left-mouse-button on the
icon in the Sketch tab of the Ribbon toolbar.

- 7| Center Point Circle (Ctrl

Creates a circle using a cq

4. Select the Center point of the top face of the 3D
model as shown.
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5. Sketch a circle of arbitrary
size inside the top face of the
cylinder as shown to the left.

6. Use the right-mouse-button to
display the option menu and
select OK in the pop-up menu
to end the Circle command.

U:T Tiwo PmtREda'lde_)

.-d ‘/g/ Pm]ect Geometry )«’/

((Unda 5 ) 7. Inside the graphics window, click once with the
right-mouse-button to display the option menu.
Select the General Dimension option in the pop-up
# Cicict o menu.

8. Create a dimension to describe the size of the circle and set it to 30mm.

(& TaoPontRectande ) |1 g [nside the graphics window, click once with the right-
- mouse-button to display the option menu. Select OK in the

= P )] pop-up menu to end the Dimension command.

= = 10. Inside th hi ind. lick ith the righ
. ) (Z proi . Inside the graphics window, click once with the right-
peon ) \ g "o mouse-button to display the option menu. Select Finish

w 2D Sketch in the pop-up menu to end the Sketch
option.
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e 11. In the 3D Model tab, select the Extrude
command by left-clicking on the icon.

)

L il

Start §ie Revolve °

20 Sketch g = Co
Sketch Extrude (E)

Creates a feature or

12. In the Extrude pop-up window, the Profile button is pressed down; Autodesk
Inventor expects us to identify the profile to be extruded. Move the cursor inside the
circle we just created and left-click once to select the inside region as the profile to be
extruded.

30

13. In the Extrusion pop-up
Srepe e | window, set the

[E] rose Exents operation option to Cut.
Select Through Al as

Solids =y .
=h the Extents option, as
o L@ P

hown below. Confirm
Qe = S ;
e the arrowhead points

oo (oo downward.
A

14. Click on the OK button
to proceed with the Cut
operation.

e The circular volume is removed
from the solid model; the CSG-
Cut operation resulted in a
single solid.
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Creating a Placed Feature

In Autodesk Inventor, there are two types of geometric features: placed features and
sketched features. The last cut feature we created is a sketched feature, where we
created a rough sketch and performed an extrusion operation. We can also create a hole
feature, which is a placed feature. A placed feature is a feature that does not need a
sketch and can be created automatically. Holes, fillets, chamfers, and shells are all placed
features.

ENVITONMENTE LEL 3TaIea

1. Inthe Create toolbar, select the Hole command by

=
@ €] Chamfer Z TH 1ok clicking on the icon.

t e | Fitet m@f shell (] Cq
| B Dieaft T TH
Hole (H)

2. Inthe Hole window, notice the Face
button is pressed down.

Hole

Placement

[ Lo1 Linear | @

3. Pick a location inside the horizontal
surface of the base feature as shown.

4. Enter 20 mm as the diameter
of the hole as shown. Do Not
click the OK button yet.

5. Inthe Hole dialog box, click
the Reference 1 button.

uuuuuu

Reference 1
Reference 2
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6. Pick the right-edge of the top face of the

base feature as shown. This will be used as
the first reference for placing the hole on the
plane.

. Enter 30 mm as the distance as shown. Do

Not click the OK button yet.

. Pick the adjacent edge of the top face as

shown. This will be used as the second
reference for placing the hole on the plane.

. Enter 25 mm as the distance as shown.

. In Holes dialog box, set the Termination

option to Through All.

Termination

11. Click on the OK button to proceed with the Hole feature.

e The circular volume is removed from the solid model; the CSG-Cut operation

resulted in a single solid.




Constructive Solid Geometry Concepts 3-27

Creating a Rectangular Cut Feature

Next create a rectangular cut as the last solid feature of the Locator.

30 Model 1. Inthe 3D Model tab select the Start 2D Sketch command

— by left-clicking once on the icon.
7z |0
Sta Extrude Revol

2D Sketch ™
Sketch

Bl Aol

f/‘ [ [ Fillet - %

A [Rectangie | A Tt Proj
rc = ngle rog N
- o -1~ Point GEWJH 3. Select the Two point rectangle command by
clicking once with the left-mouse-button on the
E T Dpogint icon in the Sketch tab of the Ribbon toolbar.

() Two Point Rectangle

4. Create a rectangle that is aligned to the top and
bottom edges of the base feature as shown. (Hit
[F6] to set the display orientation if necessary.)

5. On your own, create and modify the two dimensions as
shown.

6. Select Finish Sketch in the Ribbon toolbar to end the Sketch option.
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fi =

EDANLLE  Sketch  Inspec
) “'@ & Sw{ 7. Inthe 3D Model tab, select the Extrude
i Lof command by left-clicking on the icon.
Start Extrude| Revolve
2D Sketch ,.% 2 o

Sketch Exctrude (E)

Creates a feature or

8. In the Extrude pop-up window, the Profile button is pressed down; Autodesk
Inventor expects us to identify the profile to be extruded. Move the cursor inside the
rectangle we just created and left-click once to select the region as the profile to be
extruded.

T R | 9. Inthe Extrude pop-

v e -~ up window, set the
Profe operation option to
soics B [Brem Cut. Select To
vt Hew) Next as the Extents
—— option as shown. Set
the arrowhead points

et o [ el ] toward the center of

; A the solid model.

10. Click on the OK
button to create the
Cut feature and
complete the design.

~——— 1 CSG Cut
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Save the Model

1. Select Save in the Quick Access Toolbar, or you
can also use the “Ctrl-S” combination (hold
down the “Ctrl” key and hit the “S” key once) to
save the part.

Start  Extrude Revol ' . . . .
20 sietch' e TEveE = coil 2. Switch to the Parametric Modeling folder if it

1s not the current folder.

Sketrh

3. Inthe Save As dialog box, right-click once in the /ist area to bring up the option

menu.
View 3
Sort by v | 4. Inthe option list, select New as shown.
Group by *
Refresh . .
5. In the second option list, select Folder to create a
Paste subfolder.
Paste shortcut |, Folder @
Share with b @] Shortcu
Mew ’ @ Microsoft Access Database
h [# Bitmap image
Properties
Savein: |, Pammetric-Modeling - d
R 6. Enter Chapter3 as the new folder
Name f name as shown.
.| Chapter2 E
|, OldVersions i 7. Double-click on the Chapter3 folder
| 1| Chapter3 | 3 to open it.

8. In the file name editor box, enter Locator as the file name.

1 | ] |

File name: Locator] -

Save as type: [Mndesk Invertor Parts (" ipt) ']

9. Click on the Save button to save the file.
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Review Questions: (Time: 20 minutes.)

1. List and describe three basic Boolean operations commonly used in computer
geometric modeling software.

2. What is a primitive solid?
3. What does CSG stand for?
4. Which Boolean operation keeps only the volume common to the two solid objects?

5. What is the main difference between a CUT feature and a HOLE feature in Autodesk
Inventor?

6. Create the following 2D Sketch and measure the associated area and perimeter.

5.0

R2.3

7. Using the CSG concepts, create Binary Tree sketches showing the steps you plan to
use to create the two models shown on the next page:
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Exercises: Create and save the exercises in the Chapter3 folder.

(Time: 180 minutes.)

1. Latch Clip (Dimensions are in inches. Thickness: 0.25 inches.)

473

6,50
=150 3,50
100 | 100 |
4,00
1.00—
175
275

2. Guide Plate (Dimensions are in inches. Thickness: 0.25 inches. Boss height 0.125

inches. The two diameter 1.00 holes are through holes.)

= 1.00 -

4.25

™~
B

A

@1.00

A

2.00

250




3-32 Autodesk Inventor 2018 and Engineering Graphics

3. Angle Slider (Dimensions are in Millimeters.)

4. Coupling Base (Dimensions are in inches.)
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5. Indexing Guide (Dimensions are in inches.)

‘—_—_—_———_

3.0






